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NOTICE: Please carefully read this license agreement before copying or using the accompanying Optivity network
management software or installing the hardware unit with pre-enabled Optivity network management software (each
of which isreferred to as “ Software” in this Agreement). BY COPYING OR USING THE SOFTWARE, YOU
ACCEPT ALL OF THE TERMS AND CONDITIONS OF THISLICENSE AGREEMENT. THE TERMS
EXPRESSED IN THISAGREEMENT ARE THE ONLY TERMS UNDER WHICH NORTEL NETWORKS WILL
PERMIT YOU TO USE THE SOFTWARE. If you do not accept these terms and conditions, return the product,
unused and in the origina shipping container, within 30 days of purchase to obtain acredit for the full purchase price.

1. License Grant. Nortel Networks NA Inc. (“Nortel Networks”) grants the end user of the Software (“Licensee”) a
personal, nonexclusive license: a) to use the Software either on a single computer or, if applicable, on asingle
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transfer the Software or user manuals, in whole or in part. The Software and user manuals embody Nortel Networks
and itslicensors’ confidential and proprietary intellectual property. Licensee shall not disclose to any third party the
Software, or any information about the operation, design, performance, or implementation of the Software and user
manualsthat is confidential to Nortel Networks and its licensors; however, Licensee may grant permission to its
consultants, subcontractors, and agentsto use the Software at Licensee'sfacility, provided they have agreed to use the
Software only in accordance with the terms of this license.

3. Limited warranty. Nortel Networks warrants each item of Software, as delivered by Nortel Networks and properly
installed and operated on Nortel Networks hardware or other equipment it is originally licensed for, to function
substantially as described in its accompanying user manual during its warranty period, which begins on the date
Softwareisfirst shipped to Licensee. If any item of Software failsto so function during its warranty period, asthe sole
remedy Nortel Networkswill at its discretion provide a suitable fix, patch, or workaround for the problem that may be
included in afuture Software release. Nortel Networks further warrants to Licensee that the media on which the
Softwareis provided will be free from defectsin materials and workmanship under normal use for a period of 90 days
from the date the Software is first shipped to Licensee. Nortel Networks will replace defective media at no charge if it
isreturned to Nortel Networks during the warranty period along with proof of the date of shipment. This warranty
does not apply if the media has been damaged as a result of accident, misuse, or abuse. The Licensee assumes all
responsibility for selection of the Software to achieve Licensee's intended results and for the install ation, use, and
results obtained from the Software. Nortel Networks does not warrant a) that the functions contained in the software
will meet the Licensee’s requirements, b) that the Software will operate in the hardware or software combinations that
the Licensee may select, ) that the operation of the Software will be uninterrupted or error free, or d) that all defects
in the operation of the Software will be corrected. Nortel Networks is not obligated to remedy any Software defect
that cannot be reproduced with the latest Software rel ease. These warranties do not apply to the Softwareif it has been
(i) altered, except by Nortel Networks or in accordance with itsinstructions; (ii) used in conjunction with another
vendor’s product, resulting in the defect; or (iii) damaged by improper environment, abuse, misuse, accident, or
negligence. THE FOREGOING WARRANTIES AND LIMITATIONS ARE EXCLUSIVE REMEDIES AND ARE
INLIEU OF ALL OTHER WARRANTIES EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Licenseeis
responsible for the security of its own data and information and for maintaining adequate procedures apart from the
Software to reconstruct lost or altered files, data, or programs.
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Nortel Networks' copyright in the Software and user manual s will cease being effective at the date of expiration of the
Nortel Networks copyright; those restrictions relating to use and disclosure of Nortel Networks confidential
information shall continue in effect. Licensee may terminate this license at any time. The license will automatically
terminate if Licensee fails to comply with any of the terms and conditions of the license. Upon termination for any
reason, Licensee will immediately destroy or return to Nortel Networks the Software, user manuals, and al copies.
Nortel Networksis not liable to Licensee for damagesin any form solely by reason of the termination of this license.

8. Export and Re-export. Licensee agrees not to export, directly or indirectly, the Software or related technical data
or information without first obtaining any required export licenses or other governmental approvas. Without limiting
the foregoing, Licensee, on behalf of itself and its subsidiaries and affiliates, agrees that it will not, without first
obtaining all export licenses and approvals required by the U.S. Government: (i) export, re-export, transfer, or divert
any such Software or technica data, or any direct product thereof, to any country to which such exports or re-exports
are restricted or embargoed under United States export control laws and regulations, or to any nationa or resident of
such restricted or embargoed countries; or (ii) provide the Software or related technica data or information to any
military end user or for any military end use, including the design, development, or production of any chemical,
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9. General. If any provision of this Agreement is held to be invalid or unenforceable by a court of competent
jurisdiction, the remainder of the provisions of this Agreement shall remain in full force and effect. This Agreement
will be governed by the laws of the state of California

Should you have any questions concerning this Agreement, contact Nortel Networks, 4401 Great America Parkway,
P.O. Box 58185, Santa Clara, California 95054-8185.

LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THISAGREEMENT, UNDERSTANDSIT, AND
AGREESTO BEBOUND BY ITSTERMSAND CONDITIONS. LICENSEE FURTHER AGREES THAT THIS
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Preface

Welcome to Optivity® Campus, a graphical network management application for
midsize to large campus network environments. Optivity Campus provides an
Autodiscovery feature that automatically discovers and displays all subnetworks,
hubs, bridges, probes, switches, routers, and servers to create a blueprint of your
network configuration. Optivity also delivers advanced management for
multi-LAN, Ethernet, and token ring networks. Optivity Campus runs under both
Microsoft® Windows NT®, and Windows 95 and integrates with HP OpenView
Workgroup Node Manager (WNM), HP OpenView Network Node Manager
(NNM), or Tivali TME 10 NetView Windows-based network management
platforms for Windows.

This preface describes the contents of this guide and provides information about
how to use it along with the other publications included with your Optivity
Campus software.

Nortel Networks recommends that you read this document before getting started
with Optivity Campus network management application.

Before You Begin

This guide describes how to install Optivity Campus to integrate with HP
OpenView Network Node Manager and Tivoli TME 10 NetView on your
management station. It also describes how to set up Optivity Campus for optimal
performance. Additionally, it describes how to get started using Optivity Campus
to proactively manage your network.

This guide covers using Optivity Campus only. For information on using your
management station, Windows 95, Windows NT, HP OpenView Network Node
Manager, and Tivoli TME 10 NetView, refer to the documentation included with
those products.

201201-B
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Getting Started with Optivity Campus 7.0.2 for HP OpenView Network Node Manager and Tivoli TME 10 NetView

For detailed information about how to use Optivity Campus, refer to Using
Optivity Campus 7.0 (located on the Optivity Campus 7.0.2 Documentation CD).

Audience

This guide is intended for Ethernet and token ring local area network (LAN)
administrators with the following background:

»  Working knowledge of IBM PC terminology and operation

»  Working knowledge of Microsoft Windows NT

e Familiarity with the IP and IPX protocols

e Familiarity with either HP OpenView Network Node Manager or Tivoli TME

10 NetView

Text Conventions

This guide uses the following text conventions:

angle brackets (< >)

bold text

brackets ([ ])

Indicate that you choose the text to enter based on the
description inside the brackets. Do not type the
brackets when entering the command.

Example: If the command syntax is:
ping <ip_address>, you enter:
ping 192.32.10.12

Indicates command names and options and text that
you heed to enter.

Example: Enter show ip {alerts | routes}.

Example: Use the dinfo command.

Indicate optional elementsin syntax descriptions. Do
not type the brackets when entering the command.

Example: If the command syntax is:
show ip interfaces [-alerts], you can enter either:
show ip interfaces or show ip interfaces -alerts.

Xii
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italic text Indicates file and directory names, new terms, book

titles, and variables in command syntax descriptions.
Where avariable istwo or more words, the words are
connected by an underscore.

Example: If the command syntax is:

show at <valid_route>

valid_route isonevariable and you substitute one value
for it.

screen text Indicates system output, for example, prompts and

system messages.

Example: Set Trap Monitor Filters

separator (>) Shows menu paths.

Example: Protocols > |P identifies the I P option on the
Protocols menu.

Related Publications

For more information about using Optivity Campus, refer to one or more of the
following publications:

Getting Sarted with Optivity Campus 7.0.2 for HP OpenView Wor kgroup
Node Manager
(Bay Networks® part number 893-660-H)

Providesinstructions essential to software installation and is designed for the
experienced user.

Using Optivity Campus 7.0
(Bay Networks part number 893-786-E)
Provides complete instructions for using the Optivity Campus integrated

applications to manage, monitor, and configure your network. This document
islocated on the Optivity Campus 7.0.2 Documentation CD. To use the CD,

see page 4-24.

Release Notes for Optivity Campus 7.0.2
(Bay Networks part number 896-007-L)

Provides up-to-date information about this Optivity Campus release.

201201-B
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Getting Started with Optivity Campus 7.0.2 for HP OpenView Network Node Manager and Tivoli TME 10 NetView

You can print selected technical manuals and release notes free, directly from the
Internet. Go to support.baynetworks.comvlibrary/tpubs/. Find the product for
which you need documentation. Then locate the specific category and model or
version for your hardware or software product. Using Adobe A crobat Reader, you
can open the manual s and release notes, search for the sectionsyou need, and print
them on most standard printers. You can download Acrobat Reader free from the
Adobe Systems Web site, www.adobe.com.

You can purchase selected documentation sets, CDs, and technical publications
through the collateral catalog. The catalog islocated on the World Wide Web at
support.baynetworks.com/catal og.html and is divided into sections arranged
aphabetically:

* The“CD ROMS’ section lists available CDs.
» The"“GuidesBooks’ section lists books on technical topics.

» The"“Technical Manuals’ section lists available printed documentation sets.

How to Get Help

If you purchased a service contract for your Nortel Networks product from a
distributor or authorized reseller, contact the technical support staff for that
distributor or reseller for assistance.

If you purchased a Nortel Networks service program, contact one of the following
Nortel Networks Technical Solutions Centers:

Technical Solutions Center | Telephone Number

Billerica, MA 800-2LANWAN (800-252-6926)
Santa Clara, CA 800-2LANWAN (800-252-6926)
Valbonne, France 33-4-92-96-69-68

Sydney, Australia 61-2-9927-8800

Tokyo, Japan 81-3-5402-7041
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Chapter 1
Preparing for Installation

This chapter provides information you need to know before installing Optivity
Campusto run with HP OpenView Network Node Manager or Tivoli TME 10
NetView.

Optivity Campusis a graphical network management application that integrates
with HP OpenView Network Node Manager and Tivoli TME 10 NetView
network management platforms, allowing you to manage and monitor devices on
Ethernet and token ring networks. You will need to purchase and install these
network management platforms separately.

For more information on Optivity Campus features, see Chapter 1, “Overview,”
of Using Optivity Campus 7.0 (located on the Optivity Campus 7.0.2
Documentation CD).
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Getting Started with Optivity Campus 7.0.2 for HP OpenView Network Node Manager and Tivoli TME 10 NetView

Network Environment

Optivity Campus with HP OpenView Network Node Manager or Tivoli TME 10
NetView installed on your management station allows you to manage multi-LAN,
Ethernet and token ring network segments that consist of supported Nortel
Networks internetworking devices and agents.

System Requirements

Before you install Optivity Campus 7.0.2 with HP OpenView Network Node
Manager or Tivoli TME 10 NetView for Windows, ensure that the network
management station(s) upon which you install software meets the requirements
defined in Table 1-1.

Table 1-1. Optivity Campus 7.0.2 System Requirements

Description Requirement

Management Station Pentium IBM-compatible PC operating at 333 MHz
recommended, 166 MHz minimum

RAM 128 MB recommended, 32 MB minimum

Disk Space 125 MB for Optivity Campus 7.0.2 recommended, 111 minimum
Swap Space (Virtual 70 MB for NNM; 128 MB for NetView

Memory)

Video Adapter VGA or Super VGA adapter and display

Operating Environment |+ Microsoft Windows 95
* Windows NT 4.0 with Service Pack 4 or 5

Communications Stack |+ Winsock implementation on Microsoft TCP/IP stack.
» IPX stack is supported only under Windows 95.

Network Management |« HP OpenView Network Node Manager 6.0 for Windows NT

Platform 4.0

* Tivoli TME 10 NetView 5.1 for Windows NT 4.0
CD-ROM Dirive 8 X recommended, 2 X minimum
Mouse Microsoft Windows-compatible

1-2 201201-B



Preparing for Installation

In addition to the software requirements already stated, please note the following:

»  Optivity Campus 7.0.2 uses the Windows NT built-in TCP/IP stack. When
installing, make sure your system isfully configured and all network
communications protocols are installed and running prior to installation.

» TheOptivity Campusinstallation program saves backup copies of your
system.ini filesin the c:\opt\saved directory.

Supported Agents

Optivity Campus manages devices on Ethernet and token ring networks using the
Simple Network Management Protocol (SNMP). The SNMP agent software
either resides in the Bay Networks network management module (NM M)
firmware, or is downloaded to the NMM from the management station, or is
downloaded through the service port on the NMM. The agent software enables
SNM P communication between individual internetworking devices and Optivity
Campus.

Optivity Campus supports three types of agent software—Standard, Advanced,
or Advanced Analyzer:

» Standard agents provide activity and diagnostic information down to a
per-port level; they support a subset of the Optivity Campus features
including Expanded View™.

» Advanced agents provide amid-level feature set—these agents make Optivity
Campus A utotopology™ possible and provide higher-level information.
Advanced agents also provide partial RMON support, the Find Nodes and
Show Nodes functions, and threshold creation on core statistics.

» Advanced Analyzer agents provide the richest feature set—by providing full
RMON support and Super RMON support for collecting statistics.

For more information about agent software, see the documentation that came with
your NMM hardware.

For information about downloading agents, see Chapter 10, “Booting New
Devices and Maintaining Agents,” in Using Optivity Campus 7.0 (located on the
Optivity Campus 7.0.2 Documentation CD).

201201-B

1-3



Getting Started with Optivity Campus 7.0.2 for HP OpenView Network Node Manager and Tivoli TME 10 NetView

Internetworking Module Requirements

You can poll and manage third-party routers or bridges that offer
SNM P-compliant software or provide standard Telnet access for status from the
Optivity Campus management station using the Telnet application.

Filtering Segment Hellos for Autotopology

Configure all Ethernet bridges with the segment multicast address (the segment
hello) in their filtering tables. The segment hello allows the Autotopology feature
to operate properly. Token ring bridges need no filters. The segment hello
disposition mode must be set to discard, to ensure a correct representation of your
network topology. The following is an example:

010081000101

Hubs exchange segment hellos as well as flat network hellos. For more
information about flat network hellos, see “Filtering Flat Network Hellos” on
page 1-5. When building network views using the Autotopol ogy feature, Optivity
Campus locates bridges and identifies network segmentsas aresult of the bridge's
filtering the segment hello address.

If the bridge does not have this address in its filtering table, Optivity Campus
cannot accurately depict the segment and bridge bounds.

Figure 1-1 shows an example of the Modd 332X S high-speed bridge forwarding
table. The segment hello is a static entry; that is, it is made manually and not
changed by Optivity Campus during the Autodiscovery process.
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Preparing for Installation

TB Address Database

Page 1 of 2

Address Dispn Address Dispn Address Dispn
02608C4BEC40 LAN B * 08002002467E LAN B 02608C4A5521 LAN B
02608C423348 LAN B * 02608C579979 LAN B 0000COBFEAO6 LAN B
080090016241 LAN B * 02608C4BD242 LAN B 02608C325804 LAN B
02608C704032 LAN B 0000COEFAll6é LAN B 0000C048831A LAN B
0000CO8BES18 LAN B 80001003FEFE LAN B 0000COB7FF18 LAN B
0000C0CB3614 LAN B 0000COF5FB0O6 LAN B 0000C019041A LAN B
0207010061B1 LAN B 800010030000 LAN B 0000CODSA216 LAN B
0000C0291307 LAN B 0000C0362A19 LAN B 0000C0512114 LAN B
0000C0869E16 LAN B 02608C688641 LAN B 0000CO59FE12 LAN B
0000C06BA216 LAN B 0000C01E1913 LAN B 08002B06209E LAN B
0000C095071C LAN B 0000C08C9Cl6 LAN B 0000C025A116 LAN B
080077002662 LAN B 020701039B4E LAN B 010081000101 Discard

Next Page Prev Page Edit Table Search Item Go Page

* Unlearned

Use cursor keys to choose option.

+ Static Total Entries= 52

Static Entries= 3
Press <RETURN> to select.

Press <CTRL> <P> to return to Main Menu.

Figure 1-1.

Model 332XS Forwarding Table

Aswith all other network devices, before you can manage the Model 332X S
bridge using Optivity Campus, enter its |P address, subnet mask, and SNMP
community string. See the documentation included with your bridge for
instructions on how to update its configuration and filtering tables.

Filtering Flat Network Hellos

Unless arouter is configured for bridging, you do not need to alter router
configuration to work with Optivity Campus. The exception isto update its
address database for correct Bootstrap Protocol (BootP) server operation. From
there, you can manage the bridge using Telnet and Optivity Campus to report
status changes via color indicators.
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For routers functioning as local bridges and remote bridges, add either or both the
segment and flat network multicast address. Your entries depend on how you want
the device represented in network topology. If you add only the segment multicast
address, Optivity Campus considers the device to be a bridge. The following
addresses are examples:

Segment multicast address 010081000101

Flat network multicast address 010081000100

If you have a BootP server on the network and booting requests have to pass
through arouter (for example, the management station has boot files for modules
located on the other side of that router), configure the router address database so
that network devices can boot properly. You must update the router database with
the IP address of your Optivity Campus management station.

For more information, see the documentation that came with your bridge

or router and Chapter 10, “Booting New Devices and Maintaining Agents,” in
Using Optivity Campus 7.0 (located on the Optivity Campus 7.0.2 Documentation
CD).

Network Information Requirements

To set up network communications, you need the following information before
beginning the installation procedure:

e |Paddress of your Optivity Campus management station. The IP address
should be in standard dotted-decimal notation (x.x.x.x) and should fit the
networking requirements for your network.

* |Paddresses for NMMs, managed concentrators, bridges, routers, and any
other SNMP/IP-based network device(s) that you want to be able to access
from the Optivity Campus management station. If you are not using Optivity
Campus to manage a device, you still need | P addresses to use the Ping or
Telnet access options.

»  Subnet masks being used in your network.

1-6
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e SNMP community strings (read-only and read/write) for all devices you want
to manage. The read-only string must match for all devices or they cannot be
recognized during the Autotopology process. You can a so use the read
community strings to define domainsin your network.

» Filtering on appropriate bridges is required for proper dynamic network
views. See your bridge or router manuals for more information about filtering.

See the management guides provided with your device modules for instructions
on assigning these values.

Network Information Checklist

Before proceeding with the installation, fill in the following information in the
space below:

Default Gateway IP address

Default Gateway subnet mask

Default Gateway read community string

IP address for management station

Local subnet read community string

Commonly used read community strings

201201-B
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Chapter 2
Installing Optivity Campus

This chapter describes how to install Optivity Campus 7.0.2 to run from within
HP OpenView Network Node Manager (NNM) and Tivoli TME 10 NetView
network management platforms. Additionally, this chapter describes how to
upgrade Optivity Campus and how to uninstall it if necessary.

Before installing Optivity Campus, ensure that your management station meets
the system requirements defined on page 1-2.

It is assumed that you have already installed either HP OpenView Network Node
Manager or Tivoli TME 10 NetView network management platform on your
management station. If you have not, please do so before proceeding with the
Optivity Campus installation. For information about how to install Optivity
Campus with HP OpenView Workgroup Node Manager, see Getting Started with
Optivity Campus 7.0.2 for HP OpenView Workgroup Node Manager.

This chapter includes the following information:

e “Running the Setup Program” on page 2-2

* “Upgrading Optivity Campus’ on page 2-8

“Uninstalling Optivity Campus’ on page 2-9

“Troubleshooting Information” on page 2-10
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Running the Setup Program

This section describes how to install Optivity Campus using the Setup program.

The Optivity Campus Setup program does the following:

Lets you select the network management platform with which you want
Optivity Campus to integrate

Lets you enter your name and company name for device agent software
upgrades

Lets you specify the Optivity Campus components you want the Setup
program to install and lets you select the destination directory

Copies the Optivity files to your network management station and configures
them

L ets you specify the communications settings for your network, including IP
address, read community strings, gateway |P address, and subnet mask

Updates your system files

Toinstall Optivity Campus.

1.
2.

Start Microsoft Windows on your management station.

On Windows NT, log into the Windows NT workstation as a user with
Administrator privileges.

If the network management platform isrunning, exit it.
Start the Optivity Campus Setup program.

a. Insert the Optivity Campus 7.0.2 Software CD into the CD-ROM
drive.

If Autorun is enabled, the Optivity Campus Setup program starts
automatically. If Autorun is disabled, manually start the setup program as
follows:

b. Choose Start > Run.
The Run dialog box opens.

c. Typethefollowing linein the Command Linefield:
[CDROM_drive]:setup\setup.exe

d. Click OK.

2-2
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The Network Management Platform Selection dialog box opens.
(Figure 2-1).

Optivity Setup E2

Optivity Campusz 7.0.2 iz available for the following network,
management platforms. Chooze the one ta install far and click on
Mext

' Dptivity with HP Dperiview Workgroup Node Manager

& ptivity for HP Opentiew Metwark, Mode Manages
™ Dptivity for Tivoli TME 10 Metview

< Back I Heut > I Cancel |

Figure 2-1. Network Management Platform Selection Dialog Box

Select the network management platform that you have installed on your
management station.

Click Next.

The Setup program confirms whether or not you are logged in as
Administrator (or an equivalent user) on the Windows NT machine, and that
you have closed all NetView or Network Node Manager windows.

Click Yesor No.

If you click Yes, Optivity Setup prompts you for your name and your
company name. If you click No, you must exit the Optivity Campus Setup
program, close all windows, and thereafter rerun the Setup program.

Enter your name and your company name.

The company name should be the same name you used to register for Nortel
Networks Support Services.

Click Next.

201201-B
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10. Choosethe destination folder into which you want to install Optivity
Campus7.0.2.

11. Click Next.

The Optivity Campus Setup Components dialog box opens (Figure 2-2).

Optivity Setup E3

Select the components you want to install, clear the compaonents
you do nat want b install,

LCompaonents

Dptivity 101126 K
Mz 2560 K

— Description

Wetyiew registration files and bitmaps

Space Reguired: 109340 k.
Space Available: 1195104 K
< Back Mesit » | Cancel

Figure 2-2. Optivity Campus Setup Components Dialog Box
(HP OpenView Network Node Manager)

The Optivity Campus Setup Components dialog box for Tivoli TME 10
NetView is similar, and therefore is not shown.
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12,

13.

Select the components that you want the Setup program to install.
* NNM Registration Files—The HP OpenView registration files.

e Optivity Campus—The Optivity Campus 7.0.2 application files.

»  Misc—Various unsupported Optivity Campus applications.

By default all of the components are selected. If you are upgrading Optivity
Campus, you may only want to select certain components.

If you want to change the destination directory for a component, select that
component, click Change, and then changeit.

The default destination directory for NNM registration files and bitmapsis
c:\NNM\registration. The default destination directory for the Optivity
Campus application filesis c:\opt. The default destination directory for
miscellaneous filesis c:\opt\unsupported.

Click Next.

The Setup program copies the files to your network management station.
Thereafter, the Communications Setup Dialog Box opens (Figure 2-3).

If the installation did not complete successfully, copy the filesin the
c:\opt\saved and c:\< platform>\saved directories to another directory before
running the Setup program again.
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When you run the Setup program again, database fil es that were not copied to
the saved directory are overwritten.

Communications Setup |

Flease enter the following information about
vour seed router:

Discovery Seed Router |1 0.127.2.1
IP Address:

Subnet Mask: |255.255.255.I]

Ipublic:

Bead Community String:

Please enter the following information about
wvour network management station:

Network Management
Station IP Address: I1 34.177.125.100

Local Subnet Read
Community String:

Ipublic:

Commonly Used Read
Community Strings: I

citation
commuter
private

Add
public Delete |

stationair

(0] 4 Cancel |

Figure 2-3. Communications Setup Dialog Box

The Discovery Seed Router |P Address, IP Address, and Subnet Mask fields
are dready filled in with your management station and network settings.

Note: Optivity Campusretrievesinformation from your | P stack configuration
settings. It defaultsto using your default gateway router asyour discovery seed
router. If you wish to specify a different seed router, you can do so how or
aternatively, you can specify a different discovery seed router after
installation using the Optivity Campus Autodiscovery dialog box (see

page 4-8) or the System Preferences dialog box (see page 4-23).

2-6
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14. Check that your network information is correct, and enter theread
community string for the seed router and your local subnet.

In the Commonly Used Read Community Strings text box, enter each string
and click Add. Repeat this procedure until you have added all stringsin the
list box.

Note: You can also enter gateway and community string information after the
=>| installation us ng the Optivity System Properties dialog box. To reach that
dialog box, choose Start > Programs > Optivity for HP OpenView > Optivity
System Preferences.

15. Click Next.

The Setup program notifies you that it has modified your network
management platform files and has placed them and copies of filesfrom
previous Optivity Campusinstallationsin c:\opt\saved.

16. Click OK.

The Setup Complete dialog box opens and prompts you to restart your
computer for system modifications to take effect.

17. Click Yestorestart your computer immediately, or click No if you want
to wait beforerestarting the computer.

18. Click Finish to exit the Setup program.

19. Verify that the Start > Programs > Optivity for HP OpenView submenu
exists.

Nortel Networks recommends that you read the next chapter before starting to use
Optivity Campus.
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Upgrading Optivity Campus

This section describes how to upgrade Optivity Campus to run from within HP
OpenView Network Node Manager and Tivoli TME 10 NetView. You can
upgrade Optivity Campus from versions 7.0 and 7.0.1.

To upgrade Optivity Campus:

1. Start Windowsand log in as Administrator.

2. Closeall other programs.

3. Install Optivity Campus asdescribed on page 2-2.

When you upgrade Optivity Campus from a previous version, the Setup
program automatically saves many of the important files used by the previous
installation. All files are saved to the \opt\saved directory.

Table 2-1 lists these files.

Table 2-1. Optivity Files Saved During Upgrade

Files File name Extension Default Path
Optivity database d*, k* c:\opt\db\
Community string files comstr.ini, descdb.ini c:\opt\bin
Image files img c:\optlimages\
Configuration files .cfg c:\optlimages\

or
c:\opt\profile\

Campus Command Center <viewhame>.ccc, c:\opt\bin\

Configuration files

Optivity .ini files constr.ini, synopt.ini, c:\opt\bin
thiddata.ini, thldplt.ini

4. After upgrading Optivity Campus, copy the saved files back to their
original locationsin the\opt\ directory structure.

5. Restart your management station.
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Uninstalling Optivity Campus

This section describes how to uninstall Optivity Campus from your management
station.

During the Optivity installation, all of the system configuration files modified by
the setup program, such aswin.ini, are saved to the c:\opt\saved directory. Also,
platform files modified by the setup program are saved to a\saved subdirectory of
the directory where the platform software is installed. The Setup program then
modifies new versions of these files during the installation process.

Note: It isnot necessary to modify the win.ini file if you will reinstall Optivity
Campus at alater date. However, if you want to permanently uninstall Optivity
Campus, remove the following sections from the win.ini file:

[Optivity]

[Optivity for OpenView]
[BPTFTP]

[Synoptics Generic Apps]
[OpenView]

To uninstall Optivity Campus:

1. Restorethefilesin the\saved directoriesto their original locations.

Note: The system filesin the c:\opt\saved directories may not be current if
you installed other software packages after the Optivity Campus installation.

2. Deetethe Optivity Campusfiles.

The default directory is c:\opt\. You can right-click the default directory and
select Delete from the shortcut menu, or you can do the following:

a. UseWindows Explorer or choose Start > Programs > Command
Prompt.

The Command Prompt window opens.
b. At the command prompt, type:
rmdir \s \sq c:\opt\

3. Restart your management station.

201201-B
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Troubleshooting Information

Using Static Versus Dynamic IP Addresses

Optivity Campus does not support Dynamic Host Configuration Protocol
(DHCP). The IP address, subnet mask, and default gateway address settings for
Optivity Campus are obtained only once during the Setup process and are pulled
from the TCP/I P setting of the Microsoft TCP/IP communications stack. The
Optivity Campus management station must maintain a static | P address for the
purpose of being reachable as an |P Trap receiver and BootP server.

Verifying Connectivity

Use Ping to verify the presence of any local |P address or your default router or
gateway.
Torun Ping:
e At the command prompt, type:
ping <IP_Address_of device that you_ want_to_verify _connectivity>

If the Ping fails, you may have specified anillegal |P address, default
gateway, or subnet mask.

Note: If you ever change the network settings subsequent to install ation,

nd change the network settings in Optivity Campus by choosing Start > Optivity
> Optivity System Preferences. The Optivity System Preferences dialog box
opens. Make the network setting changes on the NM S Configuration tab of the
Optivity System Preferences dialog box. You can also perform network setting
changes by modifying the [optivity] sectionin the c:\opt\bin\synopt.ini
file.
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Chapter 3
Postinstallation Tasks

This chapter describes the tasks that you should perform after you have installed
the Optivity Campus software and before you use it.

This chapter includes the following information:

e “Understanding Windows Environment Changes,” next
» “Backing Up Database Files” on page 3-2

Understanding Windows Environment Changes

This section describes changes made to your Windows environment to optimize
performance and ensure system stability.

Table 3-1 describes the changes and additions to the system environment that are
made by the Optivity Campus Setup program during installation to your
management station environment settings.

Table 3-1. Environment Settings
Added Settings Description
ARMONHOME =C:\OPT\ARMON Verify that the paths to the Optivity and

PATH=C:\OPT\ARMON\AR_QFC;%PATH% platform directories have been added.
PATH=C:\OPT\BIN;%PATH%

PATH=C:\OPENVIEW\BIN OpenView NNM only
PATH=C:\USR\OV\BIN NetView only

201201-B
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Backing Up Database Files

This section describes how to back up your database files:

To save your map and its associated database files, save and restore the

following files to the appropriate directory:

C:\OPT\DB\TOPODB. * (includes .D1-D6, .K1-K5, .DBD)
C:\OPT\DB\DCSDB.* (includes .D1-D7, .K1, .DBD)

To restore the database, enter the following commands:

cd c:\opt\db
erase *.*
restore <backup directory> c:

To ensure proper system operation, periodically back up these files:

c:\opt\images\bptftp.out (Saved BootP/TFTP log)
c:\opt\bin\*.fnm (Saved Flat Network View maps)
c:\opt\bin\*.sgv (Saved Segment View maps)

3-2
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Chapter 4
Getting Started with Optivity Campus

This chapter describes how to start Optivity Campus from within HP OpenView
Network Node Manager or Tivoli TME 10 NetView. It describes how to discover
network devices using Autodiscovery. Additionally, it describes how to set
Optivity Campus system properties.

It is recommended that you read this chapter before you use the Optivity Campus
network management and monitoring features described in Using Optivity
Campus 7.0 (located on the Optivity Campus 7.0.2 Documentation CD).

This chapter includes the following information:

e “Starting Optivity Campus,” next

+ “Discovering Network Devices’ on page 4-3
e “Setting Optivity System Preferences’ on page 4-21

e “Using Optivity Campus Applications’ on page 4-24

Starting Optivity Campus

This section describes how to start Optivity Campus from within HP OpenView
Network Node Manager and Tivoli TME 10 NetView.

To start Optivity Campus:
1. Start Network Node Manager or NetView.

» To start Network Node Manager, choose Start > Programs > HP
OpenView > Network Node Manager.

» To start NetView, choose Start > Programs > NetView > NetView
Console.

201201-B
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2. In NetView or NNM, choose Applications > Optivity.
Thefirst timeyou start Optivity Campus, the Campus Command Center™
window opens (Figure 4-1), and it is blank. The Autodiscovery dialog box
opens blank on top of the Campus Command Center window. Additionally,
several Optivity Campus processes start and display minimized in the
Windows taskbar.
IP Discovery TScheduIer
iscovery Using Routing Tables:
|134 |1?? |25 |1

Subnet Mask 255 |255 |255 Il]

Read Community String Ipuhlic

Hop Count |4

| =121
File Edit Task Application: Add Subnet Addlessl Add
Available Subnets Subnets To Discover
Delete I
b | RMON |
FRange PINGing
From To Add
Delete I
0K I | Cancel I | Help |
For Help, press F1 T Gadei=e 2=y ry: Mot Running

Figure 4-1.

Dialog Box

Campus Command Center Window with the Autodiscovery

The Campus Command Center provides a graphical representation of your
campus network resources. You can use the Optivity Campus A utodiscovery
feature to locate devices within your network and thus populate the

appropriate Campus Command Center folders.
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Discovering Network Devices

Before you can use Optivity Campus to monitor and manage your network, you
must run the discovery features to locate and identify the devices connected to
your network.

Discovering network devices involves these tasks:
*  Running the Campus Command Center Autodiscovery process

* Running the Optivity Node Discovery process

The Campus Command Center Autodiscovery feature is independent from
Optivity Node Discovery.

Thetwo discovery types are summarized in Table 4-1.

Table 4-1. Optivity Campus Discovery Types
Discovery Description When to Run
Type
Campus Discovers Nortel Networks specific devices so that After Platform
Command they can appear in Campus Command Center Discovery
Center folders and Optivity Campus displays. Device
Autodiscovery information is stored in the Optivity device

database.

Optivity Node Discovers network nodes by getting Show Nodes  After Campus

Discovery information from Nortel Networks devices that Command Center
have Advanced agent software. The node Autodiscovery
information is added to the Optivity device
database.

201201-B 4-3



Getting Started with Optivity Campus 7.0.2 for HP OpenView Network Node Manager and Tivoli TME 10 NetView

Choosing a Discovery Seed Router

Before you run the Optivity Campus Autodiscovery, you need to specify a seed
router. You should specify a seed router that is on or near the subnet or subnets
that you are most interested in discovering as the scope of discovery is limited by

the router hop count specified relative to the seed router that you choose.

1. IntheAutodiscovery dialog box, ensurethat the Seed Router information
iscorrect (Eigure 4-2).

Autodiscovery

IP Discovery

TSchcduIer

~Seed Router
IP Address

Subnet Mask

|134 |1?? |122 |1

|255 |255 |255 |l]

Read Community String Ipuhlic
-ARP Cache
Add Subnet Address | Add_|
Available Subnets Subnets To Discover
Delete I
-Range PINGing
From I To I Add I
From{3 10.157.2.1 ToC 10.157.2.255 [Delete |

119 I | Cancel I | Help

Figure 4-2.

Autodiscovery Dialog Box—Seed Router Section

4-4

201201-B



Getting Started with Optivity Campus

The Seed Router information isread only dynamically when you select the
Router Discovery Using Routing Tables option. Therefore if necessary, select
the Router Discovery Using Routing Tables option and type any information
that you want to change.

The Discovery Seed Router isthe IP address of the router that Autodiscovery
uses as the seed to initiate the discovery process. This | P addressis written to
the synopt.ini configuration file. If the seed router |P address is wrong,
Autodiscovery fails.

The Discovery Seed Router Community String is case sensitive.

The BootP and Trap Registration processes use the Host | P Address text box
information to notify agents of the IP address of the Optivity Campus
management station. The trap registration process informs agentsto send their
traps to the Optivity Campus management station and the BootP server
process informs agents from what | P address to request TFTP agent
configuration file downloads.

2. If any of the Seed Router information isincorrect, typethe correct
information.

Alternatively, you can use the System Properties dialog box NMS
Configuration tab to specify a default router. Choose Start > Programs >
Optivity > Optivity System Preferences.

Specifying Community Strings

Community strings control access to your network resources. There are two types
of SNMP community strings.

e Read
* Read/write

The read community string controls which management station can read the
management information base (MIB) for a particular device. The read/write
community string controls which management station can have full accessto
(read and write) to the MIB of adevice.

By default, the read community string of adeviceis set to “public.” The read/
write community string of adeviceis set to “private.” This means that any
Mmanagement station can access information for that device.

201201-B
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Community strings are case sensitive.

If al of the devices on your network have the default community strings, you do
not need to specify the community string names beyond the default.

If you have changed the community strings of your devices from the default
settings, then you need to specify those changed community strings to match in
Optivity. Otherwise, Autodiscovery will not be able to discover these devices.

In the System Properties dialog box, the Community Stringstab letsyou add to or
change the non-default read community strings for devices on your network. If
you added non-default community strings during the installation process, they
appear in the tab.

To add non-default read community strings:
1. Choose Start > Programs > Optivity > Optivity System Preferences.
The System Properties dialog box opens.

Note: Alternatively, you can use the Set Community Strings utility from HP
OpenView. Choose Applications > Set Community Strings. See “ Specifying
Community Strings” on page 4-5.

4-6
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2. Click the Community Stringstab (Figure4-3).

Command Center | MMS Configuration I
System Defined Read Community Stnng:
Ipuhlic
Commonly Used Read Community Strings:
Iwhu
houston
Pubhe
who
| (1].9 I | Cancel I | Apply I | Hain I

Figure 4-3. System Properties Dialog Box—Community Strings Tab

The System Defined Read Community is already displayed. It is the default

read community string your management station uses to communicate with
devices.

3. Inthe Commonly Used Read Community Stringsfield, typea
non-default read community strings used on your networksand
subnetworks.

Perform this step only if you use multiple read-only community strings on
your Nortel Networks network devices. If the community strings are not
added to the list, Nortel Networks devices cannot be discovered or polled for
status.

Note: Do not add any read/write community strings. Add only applicable read
community strings. Community strings are case sensitive; therefore, ensure
that you type the proper case.
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4. Click Add.

The community string you just typed is displayed in the list box. To delete
community strings, select the community string from thelist box and click
Delete.

5. Click OK.

Running Autodiscovery

Thefirst timeyou start Optivity Campus, the Autodiscovery dialog box is open.
Subsequently use the Autodiscovery toolbar button or the Applications >
Autodiscovery command to open the Autodiscovery dialog box. The
Autodiscovery dialog box provides three discovery options, each on a separate
tab: IP Discovery, IPX Discovery, and Scheduler.

Note: If your management station is configured for | P only, you do not see the
=>| IPX Discovery tab. If your management station is configured for IPX only,
you do not see the IP Discovery tab. You see both tabs if your management
station is configured for both protocols.

Autodiscovery does the following:
» Discoversall of thefile and print serversin your network

» Discoversall of the Nortel Networks hubs, routers, bridges, and switches on
the specified subnet

» Discoversthe various LAN segments and ringsin your network

» Displaysthe discovered devices in the appropriate Campus Command Center
folder
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Using IP Discovery

TheIP Discovery tab in the Autodiscovery dialog box displays the three discovery
methods: ARP Cache, Range PINGing, and Router Discovery. You can use one
or all discovery methods. Table 4-2 describes each discovery method.

Table 4-2. IP Discovery Methods
IP Discovery Description
Method

Router Discovery

ARP Cache

Range PINGing

Discovers routers, networks, and subnetworks. Enable the Router
Discovery Using Routing Tables check box if you want Autodiscovery
to discover available networks and subnetworks in your network and
the routers that are connected to those networks.

Uses Address Resolution Protocol (ARP) information from routers on
the network to discover devices that communicated through the
router and have had their address logged in the router ARP cache.
ARP is a protocol for mapping an IP address to a physical machine
address that is recognized in the local network.

Sends an Internet Control Message Protocol (ICMP) echo request
to each address in the specified range, discovering network devices
that reply. In a routerless environment, Range PINGing is the only
discovery that discovers devices.
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Using Router Discovery

1. Atthetop left on the |l P Discovery tab, check the Router Discovery Using
Routing Tables check box (Figure 4-4).

IP Discovery TScheduIer
X Router Discovery Using Routing T ables:
rSeed Houter
IP Address [134 [izz 122 i
Subnet Mask [255 [256 [285 |0
Read Community String Ipuhlic
-ARFP Cache
Add Subnet Address | Add_|
Available Subnets Subnets To Discover
Delete I
-Range PINGing
From I To I Add I
From <3 10.157.2.1 ToC 10.157.2.255 [_Delete |
119 I | Cancel I | Help I

Figure 4-4. Autodiscovery Dialog Box—IP Discovery Tab

When you select the Router Discovery Using Routing Tables option, the Seed
Router area of the dialog box is enabled and you can modify the information
if necessary. Additionally, the ARP cache and Range PINGing sections of the
Autodiscovery dialog box are disabled.
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2.

If you have not already done so, ensurethat the Seed Router infor mation
iscorrect.

The Seed Router section in Router discovery will update the synopt.ini,
comstr.ini and discover.ini files accordingly, and therefore update the NMS
Configuration tab in the System Preference dialog if you made any changes.

The Router Discovery Using Routing Tables option uses the seed router to
discover all available subnets and routersin your network only. Router
discovery queries the seed router for its next hop routing table and discovers
all available networks and subnets within a specified hop count. The default
hop count for IP router discovery is 4 hops. You can also modify the default
hop count by changing the HopCount = parameter in the [X1tr
Interface] section of the discover.ini file.

Discovered networks are displayed in the Available Subnetslist box. If the
Available Subnets list box is not popul ated, check the read community string
of the default router. Open the Routers folder in Optivity Campus Command
Center and Ping and SNM P Echo test the router. If the Ping succeeds but the
Echo test fails, the most likely cause is an incorrect community string or
manager entry associated with the community string if using a Nortel
Networks seed router.

Router discovery discovers routers and automatically populates the Available
Subnetslist box on the IP Discovery tab with all of the available subnetsin
your network. It does not populate the Subnets to Discover list box that is
necessary to discover the networking devices on your network and to fill the
various device foldersin Campus Command Center.

If the Available Subnetslist box does not populate, check the read community
string and/or Manager entry for the seed router.

Asan aternative or in addition to the procedure described above, you can
manually specify the subnetsin your network that you want Autodiscovery to
discover.

To manually specify a subnet to discover, type a subnet |P address in the Add
Subnet Address Field and click Add. Repeat the process until you have added
all of the subnets that you want Autodiscovery to discover.

Once you have used one of the two discovery methods described above to
populate the Autodiscovery dialog box with subnets to discover, clicking
Discover starts the ARP discovery process (see page 4-13).
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Routers serving the specified networks are queried for the contents of their
ARP cache. Those devices whose | P addresses fall within the discovery range

are queried via SNMP to determine the device type. Those device that

respond and are of atype that Optivity supports.

[X ‘Router Discovery Using Rouling Tables:

rSeed Houter
IP Address

Subnet Mask

|134 |1?? |25 |1
|255 |255 |255 |u

Read Community String Ipublic

-ARP Cache

Add Subnet Address | Add

Available Subnets Subnetz To Discover
< 10.0.0.0 = [ Detete |
2 10.0.164.0
T 10.1.0.0
2 10.1.127.4

rRange PINGing
Froml To Add I

Delete I
114 I | Cancel I | Help I
Figure 4-5. Autodiscovery Dialog Box—Router Discovery

3. Click Discover.
The Autodiscovery process begins. The Autodiscovery icon turnsred in the
Campus Command Center toolbar. The icon turns green when the
Autodiscovery processis completed. Also the Status Bar displays
“Autodiscovery Not Running.” You see al of the available subnets on your
network (Figure 4-5).
IP Discovery [Scheduler

4-12
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Using ARP Cache Discovery

When the Router Discovery Using Routing Tables option is not selected in the
Autodiscovery dialog box,

To select subnets for ARP Cache discovery:

1. OntheAutodiscovery | P Discovery tab, deselect the Router Discovery
Using Routing Tables option.

The ARP Cache Discovery areais disabled if you have selected the Router
Discovery Using Routing Tables option.

Note: This step assumes that you have run Router Discovery Using Routing
Tables as described on page 4-10, otherwise skip to the next step.

2. Inthe Available Subnetslist box, select the available subnets within
which you want Autodiscovery to discover your networking devices.

3. Click Add.

The selected subnet addressis listed in the Discover Subnets list box
(Figure 4-6).
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Autodiscovery
IP Discovery TScheduIer
" Router Discovery Using Routing Tables
~Seed Router
IP Address 134 77 |25 |1
Subnet Mask 255 |255 [255 Il]
FRead Community String Ipuhlic
ARP Cache
Add Subnet Address | Add_|
Available Subnets Subnets To Discover
< 10.0.00 “|| 10000 [Delete |
> 10.0.164.0 3 10.1.0.0
T 10.1.0.0 r10.1.127.4
2 10.1.127.4
Ererpr -
-Range FINGing
From [101.127.4 To [10.1127.4 [ Add |
Delete I
0K I | Cancel I | Help I

Figure 4-6. Autodiscovery Dialog Box—ARP Cache Discovery

To remove a subnet from the Discover Subnets list box, select the addressin
the list box and click Delete.

4. Repeat steps2 and 3 for all subnetsthat you want Autodiscovery to
discover.

After you run discovery once, all the discovered subnets are displayed in the
All Subnets list box. If not, the read community string for the default router is
probably incorrect. You can verify the default router address and community
string using the Optivity System Preferences dialog box. Choose Start >
Programs > Optivity > Optivity System Preferences.
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If you did not run Router Discovery Using Routing Tables or wish to
manually specify the range of discovery, you can manually type the subnets
that you want Autodiscovery to discover.

To manually specify a subnet to discover, type a subnet | P address in the Add
Subnet Address Field and click Add. Repeat the process until you have added
all of the subnets that you want ARP discovery to discover.

Routers serving the specified networks are queried for the contents of their
ARP cache. Those devices whose | P addresses fall within the discovery range
are queried via SNMP to determine the device type. Those device that
respond and are supported by Optivity Campus are added to their respective
Campus Command Center folder.

To remove a subnet from the Discover Subnets list box, select a subnet and
click Delete.

5. Click Discover.

Devices belonging to networks listed in the Discover Subnets list box are
discovered by reading the ARP caches of previously discovered routers.
The Autodiscovery process begins. The Autodiscovery icon turnsred in the
Campus Command Center toolbar. The icon turns green when the
Autodiscovery processis completed. Also the Status Bar displays

“ Autodiscovery Not Running.”

Note: The ARP Cache discovery processis aware of routers on the network.
Even if you have not run Router Discovery Using Routing Tables and
Discovery isrunning for thefirst time, the ARP Discovery utility still proceeds
to retrieve routing information from the seed router so that appropriate next
hop routers to query can be discarded. This process will not, however,
populate the Available Subnets list box in the Autodiscovery dialog box.

Using Range PINGing

Range PINGing is commonly used as an alternative discovery method to router
discovery and ARP Cache discovery either to limit the scope of discovery to three
very specific address ranges or as adiscovery method for routerless environments.

Range PINGing involves sending and ICMP Ping to determine what IP devices
are alive on the network. It then sends an SNM P request to determine devicetype.
Aswith ARP Cache discovery, devices responding that are within the range of the
device type that Optivity Campus has been designed to identify are discovered.
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To select subnets for Range PINGing discovery:

1. Typethestarting and ending host addressin the From and To text boxes
(Eiqure 4-7).

Autodiscovery

IP Discovery [Scheduler

[ Router Dizcovery Using Routing Tables
~Seed Router
IP Address

Subnet Mask

|134 |1?? |25 |1
|255 |255 |255 ||]

Read Community String Ipuhlic
-ARP Cache
Add Subnet Address | Add
Available Subnets Subnets To Discover
<510.0.0.0 < 10000 <] [_pelete |
<2 10.0.164.0 <> 10.0.164.0
m R (| mm10.1.00
<7 10.1.127.4 <> 10.1.127.4
P r— o | P v | [Discover]
-Range PINGing
From |1u_1_|1u To |1I]_1_I].255 Add:
From ™ 10.0.0.0 To¢ 10.0.0.255 [ Delete ]
From ¢ 10.0.164.0 To s 10.0.164.255
From ¢ 10.1.0.0 To¢y 10.1.0.255

| OK | | Cancel | | Help |

Figure 4-7. Autodiscovery Dialog Box—Range PINGing Discovery

2. Click Add.

The specified range is added to the Range PINGing range list box.To remove
a subnet address range from the Range PINGing range list box, select the
range you want to remove and click Delete.
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3. Repeat steps 1 and 2 until you have specified all of the addresses.

4. Click Discover.

The Autodiscovery process begins.

- | Note: You can usethe Scheduler to schedule Autodiscovery to occur later at a
specified time or interval (see page 4-18).

Using IPX Discovery

IPX Discovery involves discovering the hubs from the IPX server bindery.

To usethe IPX Discovery:
1. Inthe Autodiscovery dialog box, click the IPX Discovery tab.

The IPX Discovery tab opens (Figure 4-8). If your management station is not
running IPX, thistab is not available.

|=-| Autodiscovery
IPX Discovery IIP Discovery TScheduIer
Segment Address

All Segments Discover Segments

</00000001 /00000001 | Add |
£ 00000002 £ 00000002
£ 00000010 £ 00000010

£ 00000020 £ 00000020

£ 00000030 £ 00000030

2 3ACED246 2 3ACED246

| Discover I | oK I | Cancel I | Help I

Figure 4-8. Autodiscovery Dialog Box— IPX Discovery Tab
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2. Select a segment from the Available Segmentslist, or manually type a
segment | P address using the Segment Address text box.

3. Click Add.

The selected segment address is displayed in the Discover Segments list box.
To remove a segment address from the Discover Segments list box, select the
address you want to remove and click Delete.

4. Repeat steps 2 and 3 until you have specified all of the address ranges.

5. |If you want to select I P Discovery options, see“Using | P Discovery” on
page 4-9.
6. Click Discover.

- | Note: Youcan use the Scheduler to schedule Autodiscovery to occur later at a
specified time or interval. See “ Scheduling Discovery” next in this chapter.

Scheduling Discovery

The Autodiscovery Scheduler lets you schedule Autodiscovery to automatically
occur daily or at a specific interval.

To ensure that the Optivity database is updated with the latest network
information, schedule Autodiscovery to occur on aregular basis. You can
schedule Autodiscovery to occur daily at a specified time or you can schedule
Autodiscovery to occur at specific timeintervals. Nortel Networks recommends
that you schedule Autodiscovery to occur at atime when network activity is low
and when other task are not running on the Optivity Campus management station.
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To schedul e the Autodiscovery process:

In Optivity Campus Command Center menu bar, choose Applications >
Autodiscovery or click the Autodiscovery toolbar button.

The Autodiscovery dialog box opens (Figure 4-9).

IP Discovery TScheduIer

[ Start Daily At |11 |3u ClAM & PM
[ Start At Intervals OF I His

|Discuvel| | (114 I | Cancel I | Help I

Figure 4-9. Autodiscovery Dialog Box—Scheduler Tab

Click the Scheduler tab.

To schedule Autodiscovery daily at a specific time, check the Start Daily
At check box, typethe specified timein the text box, and click the AM or
PM option.

The Start Daily At Autodiscovery option is automatically checked by default.

To schedule Autodiscovery to occur periodically at a specified interval,
check the Start At Intervals Of check box and typethe hoursin the text
box.

Click Discover to automatically start Autodiscovery at the specified time
or interval.

Click OK to save the information and close the Autodiscovery window. To
disable Autodiscovery at a specified time or interval, deselect everything on
the Scheduler tab and click OK.
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Saving a Campus Command Center View

After discovered devices are displayed in the Optivity Campus Command Center,
you can save the view, which results in creating a configuration file (.ccc).

A configuration file includes the following information:

+ Deviceinformation for each folder, such as network address, host name, or
MAC address

e Current selections in the Contents folder
e Thresholds

To save a Campus Command Center view and create a configuration file:

1. From the Optivity Campus Command Center menu bar, choose File >
Save or click the Save toolbar button.

The Save File dialog box opens.
2. Typeafilenameand click Save.

The next time you open Campus Command Center, the last saved view is
automatically loaded. The saved configuration file is displayed at the bottom
of the File menu. If you try to exit the Campus Command Center without
saving changes to your current configuration file, you are prompted to
confirm whether or not to save your changes before you exit.

Note: To view alist of previously saved views, edit the] RecentFileList]
section in the ccc.ini file. The file referenced by the “Filel=" parameter is
automatically opened the next time you start Optivity Campus Command
Center.

4-20

201201-B



Getting Started with Optivity Campus

Running Optivity Node Discovery

Node Discovery is an Optivity utility that supplements the other Optivity
Discovery processes and adds additional information to the Optivity database
using the Show Nodes information obtained from Nortel Networks devices. Node
Discovery discovers nodes in your segment and link label information (the slots
and ports through which devices are connected to other devices). Link label
information is viewable in the Optivity segment view map. Node information is
used for the Find Node application and other applications such as Nodal View.
Run Node Discovery prior to using Optivity for the first time. Additionally, run
Node Discovery periodically thereafter.

Note: For some applications, such as Nodal View, information can be
discovered dynamically and added to the database on an as-needed basis. For
other applications, such as Find Node, Node discovery must be run first before
launching the application.

To run Node Discovery:

* From the Campus Command Center menu bar, choose Applications >
Node Discovery.

Node Discovery startsimmediately discovering nodes learned by querying
devicesfor their Show Nodes tables. Show Nodes information is stored in the
Optivity database for future use.

The Node Discovery process begins. Node Discovery may take several
minutes. Node Discovery is complete when the Node Discovery window
closes.

Setting Optivity System Preferences

The Optivity System Preferences let you change preferences for the Optivity
Campus Command Center, Community Strings, and NM S Configuration. You can
change Optivity system preferences at any time so that you do not haveto reinstall
the software to update the information.
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Changing Campus Command Center Preferences

The Command Center tab allows you to change default information and MAC
address format.

To change Command Center preferences.
1. Choose Start > Programs > Optivity > Optivity System Preferences.

The System Properties dialog box opens (Figure 4-10). The Command Center
tab is displayed by default.

= System Properties

Command Center | Community Strings | M5 Configuration |

Default Time Dut [Sec): i
Default Polling Period [Sec): |50

Default Hetwork Retries [Sec):

1111

Default Out of Band Time Out [Sec): 25
MALC Address Format:

® VYendor Type [ eq. SYMOPTO19D18

O Hex Type [ eq. DDAABBD19D18 R e

| 114 I | Cancel I | Srapde I | Heln I

Figure 4-10.  System Properties Dialog Box—Command Center Tab

Typethetimein secondsto wait for a response from a device.
Typethetimein seconds for Optivity Campusto poll a device.

Typethe number of retriesfor getting information from a device.

o &~ w DN

Typethetimeout in seconds for out-of-band operations.
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6. Select the MAC Address format type that you want.

If you select the vendor type, the MAC addressis displayed in Optivity
applications by vendor name followed by six hexadecimal numbers. If you
select the hex type, the MAC addressis displayed in Optivity applicationsin
hexadecimal format.

7. Click Reset To Default if you want to go back to the default values.

Changing NMS Configuration

The network management station (NM S) Configuration tab allows you to change
the I P address of the Optivity Campus host management station, the discovery
seed router, subnet mask, and the discovery seed router community string you
entered during the installation process.

To change NM S configuration:
1. Choose Start > Programs > Optivity > Optivity System Preferences.

The System Properties dialog box opens. The Command Center tab is
displayed by default.

2. Click the NM S Configuration tab (Figure 4-11).

System Properties E

Command Center I Community Strings | HMS Configuration |

Discovery Seed |1?? | |25 | |1

Router

|
Subnet Mask |255 | |255| |255 | |u |
Discovery Seed |

|

Router |puhlic
Community String

Host IP Address |134 | |1??| |25 | |12l]

114 I Cancel | Apply | Help |

Figure 4-11.  System Properties Dialog Box—NMS Configuration Tab
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3. TypethelP address of thediscovery seed router in the Discovery Seed
Router field. Type 1.1.1.1 for a routerless network.

4. Typethesubnet mask of the network in the Subnet Mask field.

5. Typetheread community string of your seed router in the Default
Gateway Community String field. In arouterlessenvironment, accept the
default (public).

6. TypethelP address of the Optivity Campus management station.
7. Click OK to save the new information.
All the information is saved in the Optivity database.

If you click Cancel, the System Properties information is not changed in the
database.

Using Optivity Campus Applications

After you have a NetView or NNM map, you can use Campus Command Center
and the Optivity Campus integrated applications to manage, monitor, and
configure your network.

For information about using the Optivity Campus applications, see Using Optivity
Campus 7.0 (located on the Optivity Campus 7.0.2 Documentation CD), or use
the Optivity Campus Online Help System.

To view the Optivity Campus Online Help System, choose Help > Optivity Index
from the Campus Command Center menu bar.
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To use the Optivity Campus 7.0.2 Documentation CD:

1. Insert the Optivity Campus 7.0.2 Documentation CD in your management
station CD-ROM drive.

2. Choose Start > Run.
The Run dialog box opens.
3. Typethefollowing:
<CDROMdrive>:\Welcome.pdf
4. Click OK.

The Optivity Campus 7.0.2 Documentation CD interface opensin Adobe
Acrobat.

5. Click Main Menu.
Thelist of documentation opens.

6. Click the document that you want.
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